SE2352 - Let’s face it—there are many elements in our Autodesk® Revit® software models that are re-modeled by the architect, MEP engineers, or structural engineers. Who modeled it initially? Who owns it? Is Copy/Monitor being used? These types of questions should always be asked. Items such as columns, girds, ceilings, lights, plumbing fixtures, structural walls, floors, and roofs are usually populated in both the architectural model and the engineering models. This class will describe proper workflows between architects and engineers and explain how to model elements that have both architectural and engineering needs. Learn how to share the information of these elements without having to duplicate the geometry. Sometimes knowing when and how to share elements will eliminate the need to have ownership of elements. Learning to create the proper workflow and families will ensure that collaboration is being achieved on your Building Information Modeling (BIM) projects.

Learning Objectives - At the end of this class, you will be able to:

- Knowing when and what elements to monitor
- Learning how to use Collaboration Tools in Revit effectively
- Making Families with other disciplines in mind
- Getting the graphics to show what you want to show

About the Speaker

Mike has more than 15 years of experience as an architect working on various types of projects. He is currently Senior AEC Building Application Specialist at Applied Software, where he helps firms assess, plan, and implement new technology. His knowledge and enthusiasm for AutoCAD® products runs deep; he has been a user of AutoCAD since Release 9 and of AutoCAD Architecture since its debut. He has also developed a deep appreciation for Autodesk® Revit®. Mike is a contributing author of Autodesk Official Training Courseware and a repeated speaker at Autodesk University.

Rabi Sidawi, AIA education includes a B.ARCH (1985), M.ARCH (1986) and MA (1988). Since 1988 he practiced architecture in Los Angeles, Honolulu and Atlanta. Rabi is a registered Architect and a senior application consultant at Applied Software. In his current role, he provides AEC project planning/implementation, trains AEC professionals on (BIM) applications including Revit Architecture, Revit Structure, Navisworks and Ecotect Analysis. Other activities include web seminars and marketing presentations, project management, GSA BIM template creation, model error checking & validation, simulation of project phases, quantity & material take-offs and building performance analysis. Autodesk recognized Rabi as having received the highest ratings from students for instructor performance. He was named (ATC) Instructor of the Year for 2007. In 2009 he received the North America award for distinguished performance in Revit Architecture.
Table of Contents

Introduction .................................................................................................................................................. 3
Knowing when and what elements to monitor .............................................................................................. 3
Who Models What ...................................................................................................................................... 3
The Order of Modeling ............................................................................................................................... 5
Avoiding Duplication .................................................................................................................................. 6
Learning how to use Collaboration Tools in Revit effectively ................................................................. 7
Developing the Proper Workflow ............................................................................................................... 7
Copy / Monitor ............................................................................................................................................. 8
File Sharing and Storage ............................................................................................................................ 11
Resolving Conflicts between Disciplines .................................................................................................... 12
Clash Detection in Navisworks .................................................................................................................... 13
Making Families with other disciplines in mind .......................................................................................... 14
How to model elements that have both architectural and engineering needs? .................................... 14
Learn to create the proper placeholder families for other disciplines ..................................................... 14
Special considerations for Host Families .................................................................................................. 17
Special considerations for Component Families .......................................................................................... 17
Special considerations for Construction Modeling (design-build or IPD): ........................................... 18
Getting the graphics to show what you want to show .............................................................................. 20
How to control the visual graphics of your consultants linked files ....................................................... 20
Setting up Project Templates with Linked files in mind .......................................................................... 21
Setting up View Filters through Selection Sets ......................................................................................... 21
Assigning View Templates to Views .......................................................................................................... 22
Pinning and Selecting Linked Models ......................................................................................................... 22
Conclusion .................................................................................................................................................. 22
Introduction

Welcome to our session!

Building Information Modeling is all about coordination. With separate disciplines working on linked Revit models, coordination becomes more critical, and knowing the best practices will ensure that your project is coordinated. Sharing models with other disciplines typically involves linking consultant’s models together. There are times when linking models are all that is necessary, but there are also many times when linking is not sufficient. Live model elements are needed and required on most projects. This session will map the best practices for coordinating consultant’s models.

Knowing when and what elements to monitor

As collaboration between disciplines occurs on projects the following questions usually come up. It critical to both understand and answer these questions to ensure the success of the project.

- Are many elements in Revit BIM models re-modeled?
- If yes, which discipline—architect, MEP engineers, or structural engineers
- Who modeled it initially? Who owns it? Is Copy/Monitor being used?
- Which items are usually populated in both the architectural model and the engineering models?

Many times the engineers take the stance of “It’s not my problem… It’s the architect’s problem!” Taking this type of stance does not lead to a team approach on projects. All team members should be working together to ensure the best possible results for the project.

Who Models What

Having an understanding of who models what in a BIM model helps you to understand who owns what in the BIM model. Architects are usually the ones that begin the BIM model. Architects then hand their model over to the engineers to begin their process. Architects should convey to the other parties how the BIM model is set up. This will include items such as: levels, phases, design options, work sets, links (both Revit and CAD), and graphic standards.

Architect starts the BIM model

As the architect begins the modeling process, placeholders will be used in place of structural and MEP elements. The architect can, and probably will, place both structural and MEP elements into the architectural model, but at some point these elements will be replaced with the actual structural and MEP elements that the engineers place in their models.
Items created by architect – later shared with the Structural Engineer

Two key annotation categories will be initially created by the architect that will need to be live in the engineer’s models as well. The Levels and Grids should be copied and monitored in the engineer’s models to maintain coordination. Levels are required to set up the floor plan views in the engineer’s model. Engineers can create additional levels if needed, but the main floor level lines should match what is in the architect’s model. One exception would be if the structural engineer wants to have the level line at the top of steel as opposed to top of finished floor. If this is desired, the engineer can place his level line at the appropriate height, and still monitor his top of steel level line with the architect’s top of finish floor.

The other annotation category that will be copied into the engineer’s models are Grids. Column grids are necessary to be live in each model so the graphical grid head can be moved as needed to not interfere with other callouts, notes, or dimensions. Column grids should be controlled by the structural engineer. It is best practice for the architect to monitor the structural engineer’s grids.

The following is a process that could be used on column grids:

- Architect initially creates column grids
- Engineer copies architectural grid and modifies, if necessary
- Architect monitors engineer’s grid

Items created by architect – later copied, monitored & owned by the Structural Engineer

There are also key model element categories that will initially be created by the architect and later used in the engineer’s model. All of these model elements should not only be in the engineer’s model, but eventually owned by the engineer.

Structural building parts that will initially be created by the architect and later owned by the structural engineer consist of the following categories:

- Columns
- Framing
- Foundations
- Walls – Structural load-bearing & shear
- Floors
- Roofs
All of these categories are structural in nature. Architects need to ensure that these structural elements are classified as structural. Structural Columns should be used as opposed to architectural columns. Structural walls should be classified as load bearing in the properties of the wall. It is also good practice to name the wall types with a name that represents it is structural.

As these structural placeholders are changed to the actual structural elements, careful planning will need to take place as to which elements are deleted and which are changed to represent the architectural finishes of the structural elements. Unique wall, floor and roof types can be created to be used in conjunction with the structural elements to represent only the architectural finishes.

**Special Cases: Hosted Elements / Composite Elements**

There are some special cases with some elements that will be copied and/or monitored. These are hosted elements. When a hosted element is hosted to another element that is then copied and/or monitored, the hosted element is not necessarily copied. As in the case of a door in a wall, the wall and the door opening are copied, but the actual door is not. Openings in structural walls are rare, but they do exist in some models. When they do exist, once the door opening is copied, special coordination needs to be done to ensure that the door and the door opening stay in sync.

**The Order of Modeling**

The order of modeling will vary from project to project but it will follow the same procedure. As stated above, the architect will initiate the model. The architect will then hand over ownership of structural and MEP elements to the engineers. To hand over ownership means that the elements that were initially created as placeholders will be removed, and the architect will link in the engineer’s model to show these elements in his model.
The following is a modeling order that should be followed:

- Architect hands over the ownership of structural elements to the structural engineer
- Architect hands over the ownership of MEP elements to the MEP engineer
- Architect deletes elements that have been handed over to the engineers

**Avoiding Duplication**

In Revit, file size is the biggest enemy. Anything that can be done to reduce file size should be done. One of the more common mistakes in models is duplication of model elements between multiple-disciplines. It is easy to have multiple elements, almost too easy with tools such as the Copy/Monitor tool. Using the Copy portion of the Copy/Monitor tool will automatically create duplicates.

If the Copy/Monitor tool is used to gain ownership of elements, then the next step should be to remove the placeholder elements from their model.

It is best practice to use the Copy portion of the Copy/Monitor tool to copy levels and grids. These are the two categories that will remain live in all models. All other elements in the model need only to be monitored, not copied.

Taking the typical modeling order from above one more step should solve the problem of having duplicates. Here is a good example of this process using columns:

- Architect places placeholders for columns
- Structural engineer uses Copy/Monitor to initially create the columns in the structural model.
- Structural engineer replaces the copied placeholder columns with the actual columns
- Architect links in structural model with actual columns
- Architect changes his placeholder columns to architectural columns to represent column warps, if necessary.
- Architect uses the Monitor portion of the Copy/Monitor tool to monitor his architectural columns with the structural columns.
Learning how to use Collaboration Tools in Revit effectively

Developing the Proper Workflow
Engineers work with many architects. The workflow with each architect will vary, and the workflow on each project will vary. It is crucial for project workflow to be discussed at a project level for each and every project. The concept is simple-- everyone does their job with the tools that are available to them.

Revit has several tools built into the product that can be used to improve project workflow. Tools such as Copy/Monitor, Coordination Review and Interference Checking will establish a baseline to begin the collaboration workflow.

There are many questions the BIM team should discuss prior to starting a project. Here are a few questions to consider on your next project. These questions can be discussed and answered in a Pre-BIM meeting with the project team.

- How will the model be shared?
- How often are shared models updated?
- Who is cleaning up the shared models?
- Is the project broken up into multiple Linked files?
- Will Shared coordinates be used on the Project?
- Is the project broken up into worksets?
- Are match lines required for plan views?
- Are Phases going to be used in the project?
- Are Design Options going to be used in the project?
- Whose content will be used for MEP fixtures?
- Who will create and control the ceilings?
**BIM Execution Plan (BEP) – Defining what it is and how it works**

A BIM Execution Plan provides a framework for using BIM to deliver faster more cost effective projects. The BEP is a tool that is more formal than just a simple Pre-BIM meeting, but outlines the topics in a written form. The BEP is filled with information and planning templates to streamline project communications, and focuses on reducing design and construction costs through collaborative communication. By using a collaborative, adaptable template to establish project standards and responsibilities from the start, you’ll ensure that all stakeholders get the information they need during every phase of the building project.

A BEP should be used throughout the project and be revised as necessary since the project may change in scope or time. The BEP can be developed by any member of the project team. It does not have to be the architect. Even a third party can assist in writing, developing, and maintaining the BEP.

**Copy / Monitor**

The process of setting up the copy/monitor relationships should begin by selecting **Collaborate → Copy/Monitor → Select Link**. Select the linked architectural model. The ribbon will change to display the Copy/Monitor commands.

Prior to copying or monitoring elements, the options for the Copy/Monitor can be configured. The options are located in 5 tabs as shown below:

- **Levels** – Structural levels tend to call out top of steel. Architectural levels are calling out finished floor. If this is the case, you can create the levels in the file at the appropriate location and then simply use the monitor function to create a link between.

- **Grids** – Use the options on these tabs to convert the grid bubbles used by the architect into those used by the structural engineer. It is also possible to add a prefix to the grid names. For instance, you could add the value “S-” in the prefix field and then grid “A” from the architectural model will come into the structural model as “S-A”.

- **Columns** – In many respects, this is one of the most important tools. First, the structural engineer can chose to replace any column in the architectural model with an appropriate structural column. In many cases, the architect might have allowed for structure, and the structural engineer can now replace that with true structural components. Also, the columns can be split by levels if the architect has modeled them as a single column and the structural engineer needs them split.
• **Walls** – In the survey of the model above, the structural engineer should have identified wall components that will be required in the structural model. If the architect created the model correctly (with the walls broken as required) they can be directly copied in. If not, new walls might have to be created and then a monitor relationship established.
  
  o Tip: When creating the architectural model, break the walls where you anticipate the structural engineer would like to have them broken, and name your wall styles for these anticipated structural walls in a manner that makes them show at the top of the list. You can do this by adding a dash “-“ or underscore “_” at the beginning of the wall style. Make sure that you select the check box for “Copy windows/doors/openings” so the appropriate openings for those components are in the architectural walls.

• **Floors** – Similar to walls, select the floors that are to be copied into the model. Again, make sure to select the checkbox to maintain openings.

Once the options have been configured, the desired elements to be copied can be copied. It is important to note that views can be freely changed while in the copy/monitor, ensuring that you are in a view that is appropriate for the geometry being created. When appropriate (as in the case of levels) use the monitor tool to establish a manual link. After establishing these relationships and building the geometry, the structural engineer will continue modeling as required.

When the architect delivers an updated model to the structural engineer, the engineer will update the link using the link manager. Invoke the link manager from **File → Manage Links.**

Select the linked file and then **Reload.**

• If the model has changes to the items that were either copy/monitored or simply monitored, this message will appear:
• Warnings can occur because of these violations:
  o An original monitored element from the linked project changed.
  o A copied monitored element in the host project changed.
  o Both the original monitored element and the copied element changed.
  o The original element in the linked file was deleted.
  o The copied element in the host file was deleted.

In order to see what has changed, select **Collaborate → Coordination Review → Select Link**. Select the linked in architectural model and a dialog box will open detailing each of the changes.

![Coordination Review dialog box](image)

For each of the changes listed above, one of these actions can be taken:

• **Do nothing**: Take no action on the element. This changes the message status so that it can be filtered out or considered later.

• **Reject (in a host project tab only)**: There is a difference between an element in the host file and its associated monitored element. The change made to the element in the host file is incorrect, and a change has to be made to the associated monitored element.

• **Accept difference (in a host project tab only)**: This accepts the change made to the element and updates the relationship. For example, if the pair of grids was 200 mm apart, and one was moved to 300 mm away, the change would be accepted, and the relationship would now be set to 300 mm.

• **Modify, Rename, Move**: The command name changes based on the action. If the name of the monitored element has changed, the command reads *Rename*. If a column or level is moved, the command is *Move*. If a grid is changed or moved, the command is *Modify*. 
File Sharing and Storage

**Autodesk Cloud**

The ability to share large BIM files has come a long way in the past several years. Companies are no longer forced to create ftp sites to upload and download Revit files. Autodesk has created the Autodesk Cloud to assist in the ability to have constant access to the latest and greatest Revit files. The Autodesk Cloud is free to all subscription users with up to 25 GB of free storage. Access to Autodesk Cloud can be sent via email invitations and specific rights can be assigned to all who have access to the files. The Autodesk Cloud also stores file versions, access logs, and allows the ability to view files without having to download them. Autodesk 360 Mobile allows access to all the files on mobile devices (ie: ipad and android).

**BIM 360**

The Autodesk Cloud has expanded to other cloud based tools for simulation and analysis. Users can now upload the Revit model to perform analysis for the follow needs:

- Structural Analysis
- Energy Analysis
- Whole Building Analysis
- Photorealistic Rendering
- Thermal Comfort
- Computational Fluid Dynamics (CFD)
- Clash detection, Coordination, and Collaboration
- Conceptual Design and Feasibility Evaluation
- Field management, Commissioning, and Handover

The cloud based servers will continue to be developed. The advantages of using cloud based servers are: local computers are free to continue working while complex analyses are being compiled, the computer power is infinitely sized, and it is free to subscription users.
**Revit Server**

Revit also has the ability to connect to Revit Server if project teams need to work live on the same model from different locations. Revit Server works similarly to the way typical work-sharing works within a single office, in that each office will have a local server that is connected to the Central server. As users synchronize with their local central file, the local server then synchronizes with the central server.

![Diagram showing network connections between offices via Revit Server](image)

**Resolving Conflicts between Disciplines**

Once work on the structural model progresses to the point that the structural engineer is ready to deliver a model back to the architect, the architect will typically link that model in, and then use interference checking to see if interference has been created.

- The structural engineer delivers a model to the architect
- A link to the structural engineer’s file is creating using **Insert → Revit Link**.
- The architect can check for interferences by selecting **Collaborate → Interference Check → Run Interference Check**. This will display the interference checking dialog box:

![Interference Check dialog box](image)

- Notice that categories can be selected from the current project on one side, and then categories from the linked in model from the other side.  
Once the links have been established, the architect can re-check interferences each time the structural model updates.
Clash Detection in Navisworks
More comprehensive clash detection can be accomplished by using Navisworks Manage. Navisworks will allow multiple file types to be loaded to create one comprehensive model. Clash detection can be run with any or all items included in the models. Clashes can either be hard detections or soft detections. Hard being two elements actually interfere with each other, while soft includes a clear space around objects that could interfere with other objects.

Navisworks Manage is a tool that should be used in the collaboration process. It can provide a model that includes all disciplines including manufacturing models to ensure that clashes are detected prior to construction.

Clash detection analysis in Navisworks Manage can be conducted by creating search sets inside the Navisworks model. The clash search sets can be defined by discipline, by type, by category, by sub-category, by material, by file, or by level.
Making Families with other disciplines in mind

A simple but important step in collaborating with other disciplines is keeping all discipline in mind when creating both component-based families and host families. There are many families that are needed in both disciplines. Architects will typically place families that fall under another discipline’s jurisdiction.

How to model elements that have both architectural and engineering needs?
The project team should decide who is going to model what and who is going to control what. This is the key to making BIM project work effectively. There are many times that Revit elements can be created with the other discipline in mind. Let’s look at some specific examples of both component based families and host families.

Learn to create the proper placeholder families for other disciplines

- **Architectural columns vs. Structural columns**
  
  Revit has two types of columns, architectural and structural. The architectural columns have no structural properties and are typically used as either placeholders or to represent column wraps around structural columns. Structural columns have structural properties and can be used in structural analysis programs.

The architect will typically place columns prior to handing the model over to the structural engineer. These initial columns are ‘placeholders’ until the actual structural columns are determined and placed by the structural engineer. When the structural engineer receives the architectural model, copy/monitor will be used to copy and replace the architectural placeholder columns with the actual structural columns that are needed. Once the structural columns are placed, the architect can either remove the original placeholder columns or continue to use them as architectural columns wraps. Using this workflow between the architect and structural engineer, the architect should place the original placeholder columns as architectural columns not structural. Revit allows you to swap columns out, but it does not allow you to switch architectural columns to structural columns.
• **Load Bearing walls vs. non-load-bearing walls**
  Revit treats walls differently than columns. Walls can either be classified as structural or non-structural by a simple check box in the wall’s properties. The difference between using the Wall Architectural command and the Wall Structural command is that the structural check box is checked in the properties. With this understanding, structural walls can be replaced or changed to non-structural walls, unlike columns.

  When working with structural walls, the end result is to have them located in the structural model not the architectural model. Architects may initially place them, but once the structural engineer places the actual structural wall, the architect should either remove or change them to represent the architectural finishes.

  One item that causes confusion and problems with walls is determining the location line justification. As structural engineers use the Copy/Monitor command to copy the walls, the wall location line justification can shift the wall. It is best practice to try to line the location line justification with the edge of slab. The edge of slab is a known point that everyone can use to justify the walls.

• **Arch Floors vs. Structural Floors (at intermediate levels)**
  Floors in Revit are treated similarly to walls in that there is a structural check box in the properties to determine if the floor is structural or non-structural. Also, like walls, structural floors should be in the structural model not the architectural model. If the architect originally places the floors, they should be removed or changed to simply show the architectural finishes once the structural floors are in the structural model.

  Structural floors will have the ability to indicate the structural metal decking profile in sections. The structural engineer should assign the correct decking profile to the structural floors so the decking is indicated correctly in section views.

  Architects can then go back and create a simple floor to represent the floor finish. This can be a ¼" thick material that is used to indicate different floor materials or patterns.
• **Arch Roofs vs. Structural Floors (at the top level)**

Roofs are architectural families with no structural properties. Structural engineers will place a structural floor to represent the roof at the top level. Similar to structural walls and other structural elements, the structural engineer should control the structural floor representing the roof in the structural model.

The structural engineers are concerned about the structural properties of the roof. They will not typically indicate the tapered roof insulation. If tapered roof insulation needs to be indicated, it should be done so in the architectural model. The architect can create a simple roof type that is composed of just the insulation that will sit on top of the structural floor representing the roof.

![Image of roof insulation](image.png)

• **MEP equipment**

All MEP equipment and fixtures should be controlled and located in the MEP model. The architect will usually place plumbing fixtures initially to ensure ADA requirements are met. The plumbing engineer will either replace them or use Copy/Monitor to have the plumbing fixtures in the MEP model. Once the plumbing fixtures are placed in the MEP model, the architect should remove them from the architectural model.

If the architect places any MEP equipment or fixtures as placeholders, two things should be considered when creating the families. First, the equipment should be dimensionally correct. The families do not have to be very detailed, a simple box will work for most families, but they should match manufacturer’s specifications on the overall dimensions. Secondly, MEP connectors should be added so the engineers can use their content and connect pipes, ductwork, and electrical circuits. If connectors are not used, then the engineers will not be able to use the architect’s families.
Special considerations for Host Families
When structural walls are used in projects that contain openings for doors or windows, special considerations need to be applied. Most structural walls do not contain openings, but if or when they do it is important to discuss and understand what Revit does when they are Copied/Monitored.

Architectural doors and windows are not allowed to be copied in the Copy/Monitor command. Revit will copy the wall and indicate the opening for the door or window. Once the opening is copied, the opening is controlled in the structural model. If the architect follows the best practices as specified above, and removes the structural wall from the architectural model, then the door or window will be removed as well. The architect will need to create some type of non-structural wall to place the door or window into. This will allow him to control the door or window and to include it in schedules. If the architect moves the door or window, it needs to be coordinated with the openings in the structural model.

Special considerations for Component Families
Structural members have an additional element that non-structural families do not have. All structural elements will have analytical model lines. These lines are used in the structural analysis and are simple one-line representations of the structural elements. It is important to know that all structural categories will have an additional sub-category inside of the Visibility/Graphics to control the graphics and visibility of these analytical model lines. If they are not needed to be shown in any view, these can be toggled off.

Another area where that should be considered is when modeling where the structural columns are split or spliced. Many architects simply create columns from the bottom floor all the way up to the roof (spanning multiple levels). The architect should coordinate with the engineer to determine if splice points will be used or if the columns will simply span from floor to floor.
Special considerations for Construction Modeling (design-build or IPD):
If the BIM model will be used for construction or it is a design-build or IPD project, then there are two tools that can be used to assist in transition from the design model to the construction model. The Parts tool and the Assembly tool will help bridge the gap between the design model and the construction model without having to start the process over and without having to redo what the architect has already done.

Making Parts out of System Families

The new Create Parts/Divide Model tool provides a method for dividing Revit Architecture geometry into smaller parts for the purpose of creating more accurate schedules, quantity takeoffs, visualizations, and exports. It provides visibility controls and helps maintain a persistent design intent model.

You may be wondering why being able to take a System family back to its components is such a benefit. It becomes helpful when the contractor tries to simulate construction sequencing of a system family. Imagine a wall that has CMU block, brick facade, and Gypsum Board. In previous releases, the contractor could not schedule that wall being built any other way except the total wall being built at one time. Now with Parts, he can simulate the CMU being built first, then the Brick being built, and the Gypsum Board being installed last. It can also come into play when the contractor plugs the wall into his estimating program. Previously, he was not getting actual values of the components. Now he can.

If the contractor chooses to use the Parts Divide tool, he can divide or split System families. For example, if the model contains one continuous floor, the contractor may choose to sub-divide the floor into multiple sections to match the number of pours it will take to pour the floor.
Creating Assembly Views

The new Assemblies tool helps support the creation of shop drawings for pre-fabricated building assemblies such as precast walls, columns, beams and floors. An assembly can be selected, scheduled, isolated, tagged, and tracked in the project. All annotations or views created inside the assembly views will not interfere with regular views of the main model. Again, this process is bridging the gap between the design model and the construction model by taking what the architect has created and moving it to a construction shop drawing level.

An Assembly View sheet created from the model
Getting the graphics to show what you want to show
There are several tips that can be applied to get the graphics to show what you want to show. Working with linked models can cause additional procedural steps to ensure that the graphics appear correctly.

How to control the visual graphics of your consultants linked files.
When a linked file is used in a project, an additional tab appears in the Visibility/Graphics dialog box. The additional tab is labeled Revit Links, and is used to control the graphics of the linked file. By default all the graphics are set to match the host model, which is the model that the linked file is inside of. This can be changed to either match a particular view in the linked model or set to custom to have the ability to turn off or on any of the Revit categories.

Occasionally there are items created in the linked Revit model the engineer does not want to show but is not sure what category the items are on. Revit allows items inside of a linked file to be selected by using a Tab Select. Simply hover your mouse over the item and press the Tab key on the keyboard to highlight the item and then select the item with your mouse. Once the item is selected, the element or category can be hidden through the right click menu.
Setting up Project Templates with Linked files in mind.
Project templates are essential when starting a new Revit project. Project templates can contain many settings that will assist in standards and productivity. One item that does not appear in Revit templates is the Visibility/Graphics tab for the Revit links. This is due to the Template not having the links associated with the template. This tab only appears when Revit detects a linked model. A workflow that has been successful to help with linked files in templates is to load a ‘dummy’ linked file for the other disciplines. The dummy linked file is just an empty Revit model, but once loaded into the template the Revit Links tab will appear in Visibility/Graphics. This will allow views and view templates to be created that control how the links are to be displayed.

When the template is used on a project and the real link has been obtained from the consultants, the ‘dummy’ model can be replaced with the actual linked model. It is important not to unload the dummy model, but instead to use the Reload From option in the Manage Links dialog and simply replace the dummy model with the real model.

Setting up View Filters through Selection Sets
A new type of View Filter was introduced with the release of Revit 2013. Typically View Filters are created by searching for a common parameter. New in 2013, View Filters can be created by using selection sets. Simply select the objects that you want to be included in the View Filter and pick the Save under the Selection on the Modify ribbon.

Once the new Selection View Filter is created, you can use it like any other View Filter. Visibility and graphic overrides can be controlled. These new selection set filters can also be loaded from the Manage ribbon to quickly re-select the items in the set.
Assigning View Templates to Views
View templates in Revit will assist in setting up views to have the correct graphics. Different view templates can be created and used for different types of views. In prior releases if the graphics needed to change after the view template was applied, the view template would have to modified and then reapplied to all views that were created using that view template. New in Revit 2013 is the ability to assign view templates to views. This new feature will automatically update any view that has been assigned to a view template if the view template gets revised. If the view is assigned to a view template, the Visibility/Graphics for that view no longer controls the graphics. All the graphics are controlled by the view template.

Pinning and Selecting Linked Models
All linked models should be inserted using the “Auto – Origin to Origin” position setting. This will ensure that the model does not move when an updated model is received. Another step to help ensure that the linked model is not accidentally moved is to pin the linked model. Pinning in Revit will not allow that element to be moved unless the element is Unpinned.

Pinning a model does not make the model unselectable. Sometimes when working with large linked Revit models selecting the model will cause a delay for the model to be regenerated. A trick that can be used to eliminate this possibility of selecting the linked file and removing the delay is to assign the linked model to a Design Option. Design Options are used to create multiple options in the model and to be able to create views to show these options. When elements are assigned to a design option, those elements can only be selected if the design option that it is assigned to is current. So, Design Options can be used on linked models not for the intention of showing multiple options, but to allow the linked model to be un-selectable.

Conclusion
Working with consultants in Revit adds another level of complexity to the project. Knowing how to work with the consultant’s model and how to deliver a collaborated model takes teamwork. A BIM execution plan should be used to lay out the guidelines for the Revit team. Communication, coordination, and collaboration are keys to ensuring that everyone stays on the same page throughout the project. When elements are needed to be copied or monitored, remember to borrow and return rather than own and keep, and to simply monitor items rather than copy. These are the best practices that should be followed on all projects.